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SubliJet® R
Getting Started Guide for the Ricoh GX7000

© Copyright 2008, Sawgrass Technologies, Inc., Revision 1.0 September 2008.  All rights reserved. 
Printed in the United States of America.  SubliJet® R is a registered trademark of Sawgrass 
Technologies, Inc. Ricoh® is a registered trademarks of Ricoh Co. LTD.  Other trademarks and 
registered trademarks are the property of their respective owners.

No part of this manual may be reproduced or transmitted in any form by any means without the prior 
written consent of Sawgrass Technologies, Inc.  Information in this manual is subject to change 
without notice and does not represent a commitment on the part of Sawgrass Technologies, Inc.

IMPORTANT – READ CAREFULLY:
This Process License Agreement (“PLA”) is a legal agreement between you and Sawgrass 
Technologies, Inc. (“Sawgrass”). By installing the SubliJet® R ink in your printer, or otherwise 
using the Sawgrass SubliJet® R ink, you agree to be bound by the terms of this PLA. If you do not 
agree to the terms of this PLA, Sawgrass is unwilling to license the process of using the SubliJet® 
R ink to you. In such event, you may not use the SubliJet® R ink, and you should promptly contact 
your supplier for instructions on return of the unopened package.

The process of using the SubliJet® R ink is protected by U.S. and foreign patents.  Sawgrass will 
provide a complete list of the relevant patents upon request. The use of the SubliJet® R ink to 
practice the patented process is permitted by this license.

GRANT OF LICENSE: This PLA grants you the following rights: You may install and use the SubliJet 
R ink packaged herewith in your Ricoh printer to practice the printing process described in U.S. Patent No. 
5,488,907.  The use of any ink, dye, or pigment to practice the Sawgrass Process, other than a SubliJet® 
R Ink purchased from Sawgrass or its authorized distributor accompanied by a PLA, is not a licensed use of 
the Sawgrass Process. No rights to use the Sawgrass Process, except those specified herein, are granted, 
and no rights to use any other process, product, software, or hardware developed or sold by Sawgrass are 
granted or implied hereby.

LIMITATIONS ON REVERSE ENGINEERING: You agree that you will not attempt to reverse 
engineer, reproduce, or deformulate the SubliJet® R ink.

PATENTS AND COPYRIGHTS: Sawgrass owns multiple U.S. and foreign patents which apply 
to the Sawgrass Process and/or the SubliJet® R ink or its use. All patents in and to the SubliJet® 
R ink and the method of using the SubliJet® R ink are owned by Sawgrass Technologies, Inc. You 
may not copy the printed materials accompanying the SubliJet® R ink. All rights not specifically 
granted under this PLA are reserved by Sawgrass Technologies, Inc.
Made In U.S.A.

CAUTION:
	 •	 For best printing results, use the ink within six months of purchase. Please refer to the 	
		  individual ink bag/cartridge for the specific ink expiration date.

	 •	 Keep out of reach of children.

	 •	 Do not expose ink to temperatures above 100º F or below 40º F.
	 •	 Keep ink out of direct sunshine.

Sawgrass Technologies, Inc. agrees to replace any defective ink within a reasonable time, which 
shall be Sawgrass’ sole responsibility for errors or defects in these goods.

THERE ARE NO OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, BUT NOT 
LIMITED TO, ANY IMPLIED WARRANTY OF MERCHANTABILITY OR ANY IMPLIED WARRANTY 
OF FITNESS FOR A PARTICULAR PURPOSE. SAWGRASS SHALL NOT BE LIABLE FOR LOSS 
OF PROFIT OR OTHER ECONOMIC LOSS, OR FOR INDIRECT, SPECIAL, CONSEQUENTIAL OR 
OTHER SIMILAR DAMAGES.
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The following Registered Trademarks, “SubliJet®R”, “PowerDriver™R”, “PowerDriverXG®”, 
“PowerDriver R1900XG8®”, and “PowerDriverSupraXG8®”, and the trademark ColorSure™ are all 
properties of, Sawgrass Technologies, Inc.

END-USER LICENSE AGREEMENT FOR SAWGRASS SOFTWARE - 
PowerDriver™R, PowerDriverXG8®, PowerDriverLite®, PowerDriver R1900XG8®, and 
PowerDriverSupraXG8®

IMPORTANT-READ CAREFULLY: This Sawgrass Technologies Inc. End-User License 
Agreement (“EULA”) is a legal agreement between you (either an individual or a single entity) 
and Sawgrass Technologies, Inc. for the Sawgrass software product identified above, which 
includes computer software and may include associated media, printed materials, and “online” or 
electronic documentation (“SOFTWARE PRODUCT”). By installing, copying, or otherwise using 
the SOFTWARE PRODUCT, you agree to be bound by the terms of this EULA. If you do not agree 
to the terms of this EULA, do not install or use the SOFTWARE PRODUCT.

Software PRODUCT LICENSE
Copyright laws and international copyright treaties, as well as other intellectual property laws and 
treaties protect the SOFTWARE PRODUCT. The SOFTWARE PRODUCT is licensed, not sold. The 
title to, and ownership of, this SOFTWARE PRODUCT remains with Sawgrass Technologies, Inc. 
(Sawgrass).

GRANT OF LICENSE. This EULA grants you the following rights:

•	 This license is provided to you for your use according to the terms hereof. You may install	
	 and use the SOFTWARE PRODUCT packaged herewith to practice the printing process
	 described in U.S. Patent No. 5,488,907 (the "Sawgrass Process"). The use of any ink, dye or
	 pigment to practice the Sawgrass Process, other than a SubliJet ink which is purchased
	 from Sawgrass or its authorized distributor, is not a licensed use of the SOFTWARE
	 PRODUCT.  You agree not to use the SOFTWARE PRODUCT for any other purpose or in
	 any process except as expressly permitted hereby.

•	 Not for Resale. You may not sell, or otherwise transfer for value, the SOFTWARE  PRODUCT.

•	 No Reverse Engineering, Decompilation, Copying or Disassembly. You may not 	
	 reverse engineer,  decompile, copy or disassemble the SOFTWARE PRODUCT.

•	 No Rental. You may not rent, lease, or lend the SOFTWARE PRODUCT.

•	 Support Services. Sawgrass Technologies, Inc. may provide you with support services 	
	 related to the SOFTWARE PRODUCT ("Support Services"). Use of Support Services is 	
	 governed by the Sawgrass policies and programs described in the user manual, in "online" 	
	 documentation, and/or in other Sawgrass  provided materials. Any supplemental software 	
	 code provided to you as part of the Support Services shall be considered part of the 		
	 SOFTWARE PRODUCT and subject to the terms and conditions of this EULA.  With respect
	 to technical information you provide to Sawgrass as part of the Support 
	 Services, Sawgrass may use such information for its business purposes, including 
	 for product support and development.  Sawgrass will not utilize such technical
	 information in a form that personally identifies you.

•	 No Assignment or Sublicense. You may not assign or sublicense the rights granted hereby.

•	 Termination. Without prejudice to any other rights, Sawgrass may terminate this EULA if you 	
	 fail to comply with the terms and conditions of this EULA. In the event of termination, you
	 must destroy all copies of the SOFTWARE PRODUCT and all of its component parts.

Rev.2.0_120308JCR
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COPYRIGHT. All title and copyrights in and to the SOFTWARE PRODUCT (including but not limited 
to any images, photographs, animations, video, audio, music, text, and “applets” incorporated 
into the SOFTWARE PRODUCT), the accompanying printed materials, and any copies of the 
SOFTWARE PRODUCT are owned by Sawgrass Technologies Inc. or its suppliers. Copyright laws 
and international treaty provisions protect the SOFTWARE PRODUCT. Therefore, you must treat the 
SOFTWARE PRODUCT like any copyrighted material, except that you may install the SOFTWARE 
PRODUCT on a computer for the uses permitted hereby. You may not copy the printed materials 
accompanying the SOFTWARE PRODUCT. You may not loan, rent, lease, or otherwise transfer 
the other medium to another, except as part of the permanent transfer (as provided above) of the 
SOFTWARE PRODUCT.

U.S. GOVERNMENT RESTRICTED RIGHTS. The SOFTWARE PRODUCT and documentation 
are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government 
is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data 
and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the 
Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as applicable.

MISCELLANEOUS
a.	 If you acquired this product in the United States, this EULA is governed by the laws of the 	
	 State of South Carolina. In the event of any dispute arising under this license or from the use 	
	 of the SOFTWARE PRODUCT, each party irrevocably agrees to the jurisdiction of the United 	
	 States District Court for the District of South Carolina, Charleston Division.

b.	 If you acquired this product in Canada, this EULA is governed by the laws of the Province of
	 Ontario, Canada. In the event of any dispute arising under this license or from the use
	 of the SOFTWARE PRODUCT, each party irrevocably agrees to the jurisdiction of the courts 	
	 of the Province of Ontario and further agrees to commence any litigation which may arise 	
	 hereunder in the courts located in the Judicial District of York, Province of Ontario.  If this 	
	 product was acquired outside the United States, then local law may apply.
	

LIMITED WARRANTY. Sawgrass warrants that (a) the SOFTWARE PRODUCT will perform 
substantially in accordance with the accompanying written materials for a period of thirty (30) days 
from the date of receipt, and (b) any Support Services provided by Sawgrass shall be substantially 
as described in applicable written materials provided to you by Sawgrass, and Sawgrass support 
engineers will make commercially reasonable efforts to solve any problem issues. Some states 
and jurisdictions do not allow limitations on duration of an implied warranty, so the above limitation 
may not apply to you. To the extent allowed by applicable law, implied warranties on the SOFTWARE 
PRODUCT, if any, are limited to thirty (30) days.

CUSTOMER REMEDIES. Sawgrass’ and its suppliers’ entire liability and your exclusive remedy 
shall be, at Sawgrass’ option, either (a) return of the price paid, if any, or (b) repair or replacement 
of the SOFTWARE PRODUCT that does not meet Sawgrass’ Limited Warranty and which is 
returned to Sawgrass with a copy of your receipt. This Limited Warranty is void if failure of the 
SOFTWARE PRODUCT has resulted from accident, abuse, or misapplication. Any replacement 
SOFTWARE PRODUCT will be warranted for the remainder of the original warranty period or thirty 
(30) days, whichever is longer. Outside the United States, neither these Remedies, nor any product 
support services offered by Sawgrass are available without proof of purchase from an authorized 
international source.
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NO OTHER WARRANTIES. To the maximum extent permitted by applicable law, Sawgrass and 
its suppliers disclaim all other warranties and conditions, either express or implied, including, but 
not limited to, implied warranties of merchantability, fitness for a particular purpose, title, and non-
infringement, with regard to the SOFTWARE PRODUCT, and the provision of or failure to provide      
Support Services. This Limited Warranty gives you specific legal rights. You may have others, which 
vary from state/jurisdiction to state/jurisdiction.

LIMITATION OF LIABILITY. To the maximum extent permitted by applicable law, in no event 
shall Sawgrass or its suppliers be liable for any special, incidental, indirect, or consequential 
damages whatsoever (including, without limitation, damages for loss of business profits, business 
interruption, loss of business information, or any other pecuniary loss) arising out of the use of or 
inability to use the SOFTWARE PRODUCT or the provision of or failure to provide Support Services, 
even if Sawgrass has been advised of the possibility of such damages. In any case, Sawgrass’ 
entire liability under any provision of this EULA shall be limited to U.S. $5.00. Because some states 
and jurisdictions do not allow the exclusion or limitation of liability, the above limitation may not 
apply to you.
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Introduction
Congratulations on your purchase of the SubliJet® Ink System with SubliJet® R 
digital transfer inks. This system for the Ricoh GX7000 is the latest advancement from 
Sawgrass Technologies, Inc., a leader in the development of digitally driven color transfer 
technologies and related products.

Your SubliJet Ink System includes: SubliJet® R inks and PowerDriver™ R Ricoh GX7000 
color matching software. This revolutionary, comprehensive system takes sublimation 
to the professional level, allowing users to create perfect transfers with minimal effort. 
With true six-color printing, the SubliJet® R  System increases color gamut, creates 
noticeably smoother gradient transitions, captures finer detail and adds color depth. 

With this system, your printed images can be transferred onto any product designed 
to accept sublimation dyes including: ceramic, metal, tiles, mylar, polyester fabric, 
performance wear, and UniSub®, resulting in an attractive, durable product. Your 
imagination is the limit for producing brilliant, near photo-quality images on caps, 
clipboards, clocks, mugs, mouse pads, plaques, puzzles, synthetic t-shirts, and more. 
SubliJet® R Ink is ideal for markets that personalize, customize or create short-run 
output.

This document contains information for using SubliJet® R inks and helpful tips are also 
provided for getting the best results from your transfers.  The information provided 
pertains only to the use of SubliJet® R in your Ricoh GX7000  printer.  If you have 
questions about the operation of your RICOH printer, refer to the Ricoh GX7000 Printer 
User’s Guide.

Technical support is available from your Authorized SubliJet reseller or directly from 
Sawgrass Technologies, Inc.  See the section entitled Technical Support for additional 
information.

We at Sawgrass strive to provide you with the tools to make the sublimation process easy 
to learn and simple to master. We hope you will find that the tools we have developed 
will make your years in the sublimation business fun and profitable. Please feel free to 
contact us with your feedback about our products. For additional information on our 
other products, visit our web site at www.sawgrassink.com. 

Thank you and enjoy your SubliJet® Ink System.
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About this Document
This document contains descriptions and procedures for using SubliJet® R inks, along 
with additional information for getting the best results from your transfers. 

The documentation provided pertains only to the use of SubliJet® R inks in your
Ricoh GX7000 ink jet printer.  To assist you in the overall setup process, references 
are made back to the Ricoh GX7000 Printer Users Guide for instructions.

	 To help point out important information, specific instructions,
	 and helpful tips look for the following symbols:



CAUTION:
DO NOT INSTALL RICOH OEM INK BEFORE INSTALLING 
SUBLIJET R INK. Do not power ON the printer before installing 
the cartridges.
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Ink Cartridge Setup for the Ricoh GX7000

1.	 Remove the cartridges from their packaging.

2.	 Open the right front cover on the printer

3.	 Insert the SubliJet®R cartridges in the indicated order. Press each cartridge 	
	 body until it engages securely.

		  Do not shake or agitate ink carts
		  before or after installation. 

	 Cartridge Order:
	 Black, Cyan, Magenta, Yellow

4.	 Once all cartridges are in place, close the cartridge cover.

5.	 Next, the Ricoh printer driver must be
	 installed and the printer head position
	 and paper alignment position must
	 be set. 

DO NOT TURN ON THE POWER FOR THE PRINTER UNTIL YOU ARE TOLD TO DO SO. 
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Quick Start Installation - Ricoh OEM Driver
	1 .	 Unpack and setup printer as described in the setup instructions. Have the 	
		  printer plugged into a Power Outlet but not turned on.  

	 2.	 Install the Ricoh CD in the CD-ROM drive.

	3 .	 Select a language for the interface & click OK.

	4 . 	 Click Quick Install with USB, and then click next. 

	 5. 	 Follow the onscreen instructions to complete the driver installation.

	 6. 	 Once the driver is installed, the printer firmware must be updated to allow 	
		  maximum output on the printer.  To do this, go to the Ricoh website at 
		  www.ricoh-usa.com.

	 7.  	 Go to the Downloads section of the website and click on the Download Ricoh 	
		  Drivers & Software option.

	 8. 	 If you agree to the Software License agreement click OK.

	 9. 	 Under the Product Drivers and printers section, search for the B&W/Color/Gel 	
		  printer option and use the drop down list to select Aficio GX7000 and click Go.

	1 0. Click on the Firmware link and the page will redirect to the firmware 		
		  downloads.

	11 . Select the Firmware Update Version 1.13 download option.  Choose Save > File 	
		  and 	save the file to the hard drive.

	1 2. Once the file has finished downloading, find the downloaded file on the hard 	
		  drive and run the executable. 

	13 . Follow the onscreen instructions to complete the installation.  Once completed,
		  you can install PowerDriver R.
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Adjusting the Ricoh Printer Head Position & Paper Alignment Position

1.	 Open the Printers/Faxes control panel window.
2.	 Right click on the Gelsprinter GX7000 printer option & select Printing 		
	 Preferences.
3.	 At the top of the dialog window, select the Maintenance tab.  
4.	 There are two options that will be used for adjusting the Ricoh printer for optimum 	
	 output – the Adjust Paper Feed option & the Adjust Print-Head Positions 	
	 option.
5.	 Start by selecting the Adjust Paper Feed option. 

6.	 Follow the screen shots to print out a test sheet.
7.	 Once the test sheet has printed, review the page to determine the optimum level for 	
	 your printer. 

Figure 1



Figure 3

8.	 To determine which value is optimum, look for the number that appears on the left 	
	 of the lightest gray square with straight horizontal lines on both sides. (Figure 1) 	
	 When horizontal lines beside the lightest gray square are broken, select the optimal 	
	 adjustment value by referring to the lines broken in the opposite direction.
	 (Figure 2)

				    Figure 1				    Figure 2

9.	 Once the optimum value is decided, go back to the printer dialog window & type in 	
	 the value.  Hit Next to complete the change.

10.	Next select the Adjust Print-Head Positions option.

11.	Follow the screen shots to print out a test sheet.  Select the Quality Priority/Speed 	
	 Priority option for printing the test pattern.

12.	Once the test sheet has printed, review the page to determine the optimum level for 	
	 your printer. 

						13      .	To determine which value is optimum, look for the column
							       number that appears above the lightest gray square
							       with straight vertical lines on both sides for each row.

						14      .	Once the optimum value is decided, go back to the
							       Printer Dialog Window & type in the value.  Hit Next
							       to complete the change.

15.	Follow the instructions on the next pages to install the PowerDriver R software.  	
	 Once completed, run a test print to see if the settings are acceptable.  If banding is
	 extreme, start from step one and adjust the settings again until the optimum print
	 value is found.

Next is the loading of the software. You will need to load the PowerDriver R Ricoh 
GX7000. Please follow the instructions in the PowerDriver section.
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Introduction
Using PowerDriver R Ricoh GX7000
SubliJet digital printing systems are comprised of a few key tools to ensure high quality 
output each time you print with SubliJet R Inks. PowerDriver R Ricoh GX7000 color 
management software is one of those tools.

PowerDriver R Ricoh GX7000 color management software is a professional grade color 
management program that provides SubliJet users with the necessary tools to ensure 
colors print right the first time.  PowerDriver R Ricoh GX7000 software is available for 
all major Windows based operating systems. To be sure of system compatibility, please 
visit us at http://www.sawgrassink.com/v.php?pg=296.

PowerDriver R Ricoh GX7000 software and profiles are intended to give you simple, easy 
to use color management tools to take the guesswork out of sublimation printing.  With 
the click of your mouse you can automatically optimize colors for popular substrates like 
Unisub™, polyester performance apparel, ceramics, metal, and many others. This is a 
valuable tool that saves you time, money, and limits your need for costly sampling trying 
to get the job right.

PowerDriver R Ricoh GX7000 also comes standard with the ColorSure Palette matching 
system.  The ColorSure Palette is absolutely the best way to achieve spot color accuracy 
in sublimation transfers. The palette allows you to fill solid portions of artwork with a 
color from the palette, thus knowing how it will look once transferred. With the help of 
the ColorSure Palette, you will successfully choose the correct colors, whether you are 
matching colors for a custom order or selecting colors for new artwork.

PowerDriver R Ricoh GX7000 is the most advanced color management software available 
on the market for digital transfer systems. This software was developed specifically for 
desktop sublimation systems; you will discover enhanced functionality as well as a new 
level of color output when PowerDriver R Ricoh GX7000 is used. Used in conjunction 
with SubliJet digital transfer inks you and your customers will truly experience the next 
generation in digital color!

PowerDriver R Ricoh GX7000 System Requirements

Minimum Hardware:
Pentium 4 – 3.0GHz or Athlon XP 2000+ Processor
512 MB System Memory

Recommended Hardware:
Pentium 4 – 3.0GHz or Athlon XP 2500+ Processor
1 GB System Memory

Required Operating System:
Microsoft Windows  XP & Vista (32 Bit only)
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Setup Instructions
Product Overview
PowerDriver is color management software that has been written as a Windows printer 
driver.  It is designed to work with Ricoh Ink-Jet Printers and Sawgrass sublimation ink. 
The installation program will automatically install Sawgrass color management software, 
the Sawgrass PowerDriver R Ricoh GX7000 printer driver software, and ColorSure 
tools and utilities.  For instructions on installing PowerDriver R Ricoh GX7000 see 
the PowerDriver R Ricoh GX7000 Step by Step Installation documentation starting 
below.
				    CAUTION:
					     The Ricoh OEM Driver must be installed and all updates 
					     to both the driver & firmware must be completed before
					     installing PowerDriver R

Quick Start Installation - PowerDriver™ R
	 1.	 Insert the PowerDriver CD into the CD ROM drive on the computer and install
		  the PowerDriver™ R for the Ricoh GX7000. 

	 2. 	 Follow the on-screen instructions to complete installation.



Figure 1

Figure 2
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PowerDriver™ R Ricoh GX7000 Setup
	 To get started printing as soon as possible, these are the Sawgrass
	 recommended steps to perform while setting up your sublimation
	 printer driver software.

Step by Step Installation
1.	 Insert the PowerDriver™ R Ricoh GX7000 CD into your CD-ROM drive.  The 	
	 installation program should run automatically.  (If the program does not
	 automatically run, click Start > Run.  Browse to your CD-ROM drive and click on
	 Setup).

2.	 The Welcome Screen is displayed next.  Click Next to proceed. 

3. 	 The License Agreement is displayed next.  Select the appropriate 		
	 choice for acceptance of the License Agreement to continue.



Figure 3

Figure 4

Figure 5
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4.	 The installation program will now open the Choose Components Option. Ensure
	 that the Add Printer, Register & Install application palette boxes are checked 	
	 and click “Next.”

  

5.	 The Product Registration Screen 	
	 will appear and ask if you would 	
	 like to Register Now. Click“Yes”
	 In the PowerDriver R Ricoh 		
	 GX7000 Registration Screen,
	 you will use your Product ID to 		
	 obtain a Registration Code. You 	
	 will need a separate Code for
	 every machine on which 		
	 PowerDriver R Ricoh GX7000 is
	 installed. In Figure 5, Click on the
	 button labeled “Click Here to 		
	 Obtain Registration Code”.

	 To obtain your registration 		
	 code you may do so in one of 	
	 the following ways:

	 a)	 Register On-line and receive
 		  your Registration Code via
		  E-mail.

	 b)	 Call Sawgrass Technologies, 	
		  Inc. directly (888) 253-1679
		  and obtain your Code over
		  the Phone.

	 c)	 Send a Fax and receive your 	
		  Registration Code by Fax.



Figure 5

Figure 6
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6.	 If you choose to register on-line.  The Product Registration Web Page now opens. 	
	 Complete the requested information on the web page and click Continue.

7.	 Once the website registration information has been completed, a “Thank You” 	
	 message will appear.  An e-mail will be sent to the address you specified.   Retrieve
	 the registration e-mail from your in-box and make note of the Registration Code
	 given. Toggle back to the PowerDriver R Registration Screen and enter this number
	 in the “Registration Code” Box at the bottom of the “Power Driver R Ricoh GX7000
	 Registration” screen shot shown on the previous page. Click “Apply Code”. Screen
	 will appear indicating that you have successfully registered your driver software.
	 Click - to continue the installation process.



Figure 8
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				    If you decide to register later, and continue using the driver
				    during the initial five day Pre-registration Grace Period, your
				    system will generate a Pop-Up Screen stating
				    you need to register. Go to the Printing Preferences page 
				    of  the PowerDriver R Ricoh GX7000 Driver and click on 
				    “Register.”

8.	 The Color Management Check Screen will appear. Click the “Continue” Button on
	 the left side of the screen after you have disabled the Color Management feature
	 of the Corel or Adobe Graphic Software. Click “Show Me How” if you need
 	 instructions on how to accomplish this Sawgrass Technologies, Inc. ColorSure
	 Color Palettes for use with Corel® and Adobe®, (See Appendix A). (Check
	 the ColorSure section, (Page 29) for information on how to use ColorSure to get 
	 perfect spot colors).  If Setup detects 	 either of these applications on your
	 system, the Palette Files will be placed in the appropriate folder indicated 
	 in the Destination Folder Box.  Click “Continue” to proceed with the installation.

			   Note:	 In order to use PowerDriver Color Management Software,
					     the color management features in either Corel® or Adobe® 	
					     Programs  must be disabled. Please see the instructions in 	
					     Appendix A, or click on the “Show Me How” Button on the 	
					     “Color Management Check” Screen shown in the next step.



Figure 10

Figure 9
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9.	 The Powerdriver R installation program will show the progress of the installation 	
	 in a status monitor.

     			   Note:	 Cancel any ‘Found New Hardware’ wizards that may start 	
					     during this process, do NOT cancel any file copy processes.

10.	If you see the “Hardware Installation” Screen below, click “Continue Anyway” to
	 proceed with the Installation.



Figure 11

Figure 1
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11. Once the installation has completed, the “Installation Complete” Screen will 	
	 display.  Click “Close” to end the installation. Congratulations, you are now ready 	
	 to experience creativity on a whole new level.

Using PowerDriver Ricoh GX7000 in
Windows XP and Vista
	 PowerDriver R Ricoh GX7000  is simple to use. Whenever you have SubliJet R 	
	 inks in your printer, you should print using PowerDriver R.  Do not print to
	 your Ricoh Printer with the Ricoh Printer Driver since printing with the
	 OEM Driver will not give you the benefit of color management.
Quick Start Example (CorelDRAW)
1.	 Open/Create an image in CorelDRAW.  Select Print from the File Menu.



Figure 3

Figure 2
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2.	 Select “PowerDriver R GX7000”.  Use the Properties Button to access the 
	 “PowerDriver Document Properties” Screen. so that you can set the Size,
	 Substrate, Color, and Resolution that your image requires. Click “OK”.

3.	 The “PowerDriver Document Properties” Screen allows you to set the Paper Size,
	 Paper Type, Substrate, Color, and Resolution that your image requires. Click “OK”. 
	 This returns you to the CorelDRAW ”Print” Screen. Click Print to proceed.



Figure 1

Figure 2
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Setting PowerDriver R Document Properties
	 To configure PowerDriver R GX7000 for the correct substrate, you must
	 display it’s Document Properties.  There are two ways to display the
	 Document Properties:

From the Windows Desktop:
	 1.	 Click on Start> Printers and Faxes.

	 2.	 Right-click on your PowerDriver R GX7000 (Pointer 1) and select Properties
		  (Pointer 2) from the Pop-Up Menu.   



Figure 3

Figure 4
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	3 .	 This takes you to the “PowerDriver R GX7000 Properties” Screen shown in 	
		  Figure 3 below.

	4 .	 Click on the “Printing Preferences” Button, bringing you to the “PowerDriver
		  R GX7000 Printing Preferences” Screen (Figure 4).  After setting the Paper Size, 
		  Paper Type, Number of copies, Substrate, OEM printer, and Color that your image requires,
		  Click “Apply”, then “Ok”, to return to the “Properties” Screen. Click “Ok”
		  to return to the “Printers” List.



Figure 2
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2.	 From the “Print Setup” Screen, choose the PowerDriver R Ricoh 		
		  GX7000  from the scroll-down list.  Click the Properties Button. 

From an Application:
	 1.	 Select File, > Print Setup.
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PowerDriver R Ricoh GX7000  Printing Preferences Overview
The following figure shows the printer properties for a Registered version of PowerDriver 
R Ricoh GX7000 Printer Properties.

There are three main property groups; 
	 1.	Configuration – Set Paper, Transfer Substrate, Copy Count and OEM 		
					     Printer.

	 2.	Color Options – Color Management Control Options & Print Resolution.

	3 .	Resources– Utilities, (for printer maintenance), online Help, & Product Registration.

Group 1  	– Configuration

Paper Size – From the drop down list, select the paper size you wish to use. 

Substrate  – 	From the drop down list, select the type of material to which you 	will be
		  transferring your printed image.  It is important to choose the correct
		  substrate.  PowerDriver’s color management is optimized for each 	
		  different substrate.

Copies       – Sets the copy count for the number of prints to be made.

OEM           	 – 	Sets the OEM Printer Configuration for the printer used.
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Group 2 - Color Options
Overview
This tab gives you access to all of the color management controls available in PowerDriver 
R.  Utilizing the power of the Ricoh GX7000 Driver technology, the PowerDriver  
interprets bitmap and vector elements in a similar manner.

Vector and Bitmap Explanation
Bitmaps are a grid of pixels.  Bitmaps come from digital cameras, scanners, and 
photo CDs.  Bitmaps can also be created in applications like Corel PhotoPaint or 
Adobe PhotoShop.  Bitmaps have file extensions like GIF, JPG, BMP, and TIF.  Vector 
components consist of shapes, curves, lines, and text.  They are created in programs 
such as CorelDraw and Adobe Illustrator.  Higher end programs like CorelDraw can 
combine Vector and Bitmaps into a single image.  PowerDriver will color correct all 
bitmaps files and vector components as bitmap images.

Bitmap Options
•	 No Color Management –  To unleash the power of the PowerDriver Software, the
	 color management will need to be turned off (over-ridden) in the Graphic Software.
	 (Instructions on how to do this are provided in Appendix A,Pages 20 thru 24,
	 covering Corel & Adobe Applications.)  This facilitates optimum color management
	 of SubliJet inks.  If you select the “No Color Management” option, all color
	 management will have to be accomplished using the Graphic Design Software, i. e.
	 the Corel &/or the Adobe Applications.		
•	 Saturated - Intended for use with clip art, text and other vector based graphics or 	
	 images that contain saturated colors.  

•	 Realistic - Intended for use with photographs or images that contain prominent 	
		  skin tones or highlights.

•	 Intense - Select this setting to get the most intense color output possible.

•	 Grayscale - This setting is intended for use with grayscale images.

•	 ColorSure Checkbox - ColorSure is used to replace specific colors in your image 	
	 with a spot color chosen from the ColorSure palette. This resulting spot color
	 enhancement is not affected by color setting.  A ColorSure spot color will ALWAYS 	
	 print the same.  (Please see Appendix B, for an overview of ColorSure.)

ColorSure Options
•	 Print Palette Button – Prints the ColorSure Palette for the selected substrate.
	 ColorSure is a tool for reproducing exact spot colors.  The two main components 	
	 are: 	1) The Transferred Palette, and 2), The CorelDraw, Corel PhotoPaint, and 	
	 Adobe swatches.  For a complete description on how to use ColorSure to get 	
	 perfect spot colors, see Appendix B.

•	 Custom Palette Button – This button launches the Custom Palette Utility, which
	 enables you to add, edit, import, and export custom colors to the ColorSure
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	 Palette. If you need to precisely match a specific color, the Color Finder Tool makes
	 this a breeze.  For a complete description on how to use the Custom Palette, see 	
	 Appendix B.

Output Options
•	 Mirror – When you transfer an image, the result will be “flipped” when compared 	
		  to  the printed image.  In order for your transfers to come out correctly, 	
		  you  must “flip”, or mirror the image before transferring.

Group 3 – Resources
•	 Nozzle Check Utility – Click this button to print a nozzle check pattern. If any of 
	 the nozzle check patterns are incomplete, then perform a printhead cleaning cycle. 
	 Individual channels maybe cleaned using this utility.

•	 Head Cleaning -  Performs a printer head cleaning, after which a Print Nozzle
	 Check should be performed to verify that the heads are completely cleaned. Repeat 
	 the Head Cleaning until a complete nozzle check pattern is produced. 
•	 Help – This will display a help dialog box for an easy overview of the PowerDriver
	 R GX7000 Driver functions and settings.  Also contains a link to the Sawgrass
	 Technologies Website.

•	 Register – If the PowerDriver R GX7000 product has not been registered, click
	 this button for instructions on how to register the product and unlock all the features.

•	 Sawgrassink.com – Links directly to the Sawgrass Technologies Website for
	 additional resources.

•	 Print Primary – Use this function to print a page of the primary R Ink Colors 

	 Cyan, Magenta, Yellow and Black).



Figure 1
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Appendices
Appendix A: Over-riding Application Color Management
PowerDriver provides a complete color management solution for your SubliJet printing.  
It is extremely important that you turn off any color matching features associated with 
your design software. An explanation of how to disable print-time color management in 
several popular design packages follows:

CorelDraw™ versions X4, X3, 12, 11, & 10
•	 Create a new graphic.
•	 From the main menu choose Tools > Color Management. In the Color Management
	 Window, set the Style Option to Color Management Off.

CorelDraw™ version 9
•	 Create a new graphic.

•	 From the Main Menu choose Tools > Color Management. The Color Management 	
	 Dialog Box is displayed.

•	 In the Color Management Window, UNCHECK the “Calibrate Colors for Display” 	
	 Box.
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Please Note:
	 Screen shown is from
	 CS3.  Other screens 	
	 will appear with
	 slight differences, 	
	 however the settings 	
	 remain the same 	
	 throughout.

Adobe Photoshop CS3, CS2, CS, Photoshop 7 & 6.
Color Setup
	 From the Main Menu, choose Edit, > Color Settings. In the Color Settings 	
	 Dialog Box, turn all Color Management Policies to “Off”. (See below.)  Mark 	
	 the box “Ask When Opening” next to “Profile Mismatches.

To Print; Adobe CS3:
Select File, > Print.  On the print dialog page, set the options as follows:
•	 Upper Right Hand Menu to “Color Management”
•	 Choose “Document” by clicking the radio button.
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b.	 Choose Color Management in the drop-down menu.
c.	 Choose “Document” by clicking the radio button.“
d.	 Under “Options > Color Handling” choose “No Color Management”.   

To Print; Adobe CS2, 
Always select File, > Print with Preview.  On the print dialog page, set the options as 
described in the following a thru d:
a.	 Click on “More Options”.
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a
b
c

d

Adobe Photoshop Elements 5.0/4.0/3.0:
	 Select Edit and then Color Settings from the top drop down Menu Bar.  Select No 	
	 Color Management. Click Ok.

To Print; CS and Photoshop 7:
Always select File, > Print with Preview.  On the print dialog page, set the options as 
described in the following a thru d:
	 a.	 Click on “More Options”.
	 b.	 Choose Color Management in the drop-down menu.
	 c.	 Choose “Document” by clicking the radio button.
	 d.	 Choose Same as Source for Print Space.
From the Color Management drop option list, make sure that Source is set to 
“Document” and Print Space is set to “Same As Source”.
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To Print RGB Graphics
Click File, > Print, then set the 
Range, Print Quality, & Copies.

Fill in radio button “Document: 
Intagged RGB”.

In “Print Space”, “Profile” 
should read: “Same As Source”.

Press “OK”.

To Print CMYK Graphics
Click File, > Print, then set the 
Range, Print Quality, & Copies.

Fill in radio button “Document: 
Intagged CMYK”.

In “Print Space”, “Profile” 
should read: “Printer Color 
Management”.

Press “OK”.
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Appendix B: Using ColorSure™ and Custom 
Palette in PowerDriver®

I.	 Introduction
	 ColorSure is a method for reproducing exact spot colors.  There are four main
	 components of the ColorSure System:  1.) The transferred palette; 2.) Color
	 Finder;  3.) Custom Palette; and 4.) The CorelDRAW and Adobe application 	
	 palettes / swatches.  

1.	 ColorSure Palette: This is your main color palette that includes 	 	 	
	 commonly used colors.	
2.	 Color Finder: If a color you need is not on the ColorSure Palette, the Color 	
	 Finder tool allows you to locate the exact custom color you are looking for.
3.	 Custom Palette:  With the Custom Palette feature, you can add new custom 	
	 colors to the existing ColorSure Palette mentioned in step 1.
4.	 Application Palettes:  You can add your Color Finder colors to an existing
	 application palette, or you can add multiple custom colors to new, custom 		 	
	 palette files (*.cpl, *.acl, etc.). 

•	 Click ‘Start’ and navigate to the ‘Printers and Faxes’ folder.  Right-click on 
	 your PowerDriver icon and select ‘Printing Preferences’ from the menu.
	 You 	 may also open PowerDriver from within an Adobe or Corel program by
 	 going to File, Print, and choosing the PowerDriver Printer from the pull-down
	 menu.  Click Properties to open PowerDriver.

•	 Choose the paper size you will be printing the palette to (Letter, Legal, etc.)

•	 Choose the substrate that you will be transferring the palette to.

•	 Select the speed / resolution of the palette – High Speed or High Quality.

•	 Be sure to check the box to mirror your print, click ‘Print Palette,’ and then 	 	
	 transfer the palette to the previously selected substrate.

•	 You now have a visual representation of how the ColorSure Palette colors will 	 	
	 appear on that particular substrate.

To print the ColorSure palette, follow the steps below:

The first step you will want to take is to print and transfer your ColorSure Palette 
to the various substrates you will be using.   Most likely you will have customers 
who desire precise colors.  Having your ColorSure Palette available allows the 
customer choose the color from the palette that is the closest match to what they 
want, and this gives you a starting point for finding the exact custom color that will 
match your customer’s needs.  

II.	 Printing the ColorSure Palette
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HINT
After you have the ColorSure Palette loaded into CorelDraw, move the 
cursor over each color.  As the cursor hovers over each different color, 
the ColorSure Name is displayed in the status area below each color.

IV. Using Color Finder
After printing and transferring the ColorSure Palette, you see that you have an array of
colors to work with.  There will be times, however, when the color you need is not included 
in the ColorSure Palette.  This is where the Color Finder Tool comes in handy.

III.	Designing Your Artwork
	 By picking colors from the ColorSure Palette, you will be able to consistently 	
	 reproduce colors in a reliable manner.  To assist you in designing your artwork,
	 PowerDriver installs three palettes:  two for Adobe products and one for Corel
	 products.  These colors match the palette that is printed from within PowerDriver.

•	 To open the ColorSure Palette in Corel 9,10, 11, 12, X3, or X4 choose: Window| 
Color Palette| Open Palette.  Select the file “ColorSure Palette Corel.”

•	 To open the ColorSure Palette in Illustrator, choose Window | Swatch
	 Libraries | Other Library.  Navigate to where it was installed when you 
	 installed PowerDriver: C:\Program Files\Sawgrass\PowerDriver\Adobe 		
	 Illustrator and hit Open. For easier access to the Palette, File-Copy it from
	 this [above] path to Illustrator10\Presets\Swatches and it will show up in 		
	 your pull-down list directly under the Swatch Libraries Menu.  Other versions 	
	 of Illustrator will have similar steps.
•	 To open the ColorSure Palette in Adobe PhotoShop, choose the Swatches 		
	 Palette, click the option arrow on the palette, choose Replace Swatches and 	
	 pick the “ColorSure PDIQXGv1. aco” file.
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•	 To use Color Chooser, simply click on the 
‘Start Color Chooser’ button in the “Color Finder” 
Section, at the top right of the “PowerDriver Custom 
Palette Utility” Window.  You can then choose 
a color from the basic color selection, or you can 
click on the Color button at the right of the window.  
This will display a color matrix.  To define a custom 
color, click anywhere in the matrix. Use the slider at 
the right of the matrix to adjust luminosity. Clicking 
‘OK’ will automatically fill the RGB boxes with the 
corresponding values. (Figure 3)	
•	 For advanced users, RGB values can be 
determined by printing out a Custom Palette, 
which is outlined in the next section.

Figure 1

Figure 2
Figure 3

Slider
Bar

Color Chooser Dialog Window

The Color Finder Tool allows you to start with a specific color (e.g. navy blue) and find 
similar colors in the same family by adding and subtracting up to three colors (RGB) 
called ‘Step Colors.’  For example, starting with navy blue with an RGB value of 6,6,85 
and choosing two step colors (e.g. blue and red) would expand the original navy blue in 
four directions (more blue, less blue, more red, and less red).  This expanded color chart 
– specific to a particular substrate and printing speed – prints directly to your printer.
How to use Color Finder:
•	 Open the PowerDriver window as instructed in “Printing the ColorSure Palette”
	 outlined in Section II.
•	 At the bottom of the window, click the Custom Palette Button; this will open the 	
	 Custom Palette Utility window. (Figure 1)
•	 First, make sure you select  PowerDriverIQ, then your desired Substrate & Output.
	 (High Speed or High Quality) This activates the “PowerDriver Custom Palette
	 Utility” Screen. (Figure 2)
•	 In the “Color Finder” Section, at the right, click on the “Start Color Chooser” 	
	 button and select your desired starting color from the matrix.  If you do not wish 	
	 to use Color Chooser, you may opt to manually enter the Start Color values in the 	
	 RGB boxes. (Figure 3, page 32.)
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You may alter the chosen color’s RGB value by selecting two or three Step Colors.   Using 
multiple step colors will present you with a greater range and variety of colors to choose from.

	 •	 For instance, if you choose to modify your Start Color with two steps, then Step 	
	 	 Color 1 will change its values on the X (horizontal) axis and Step Color 2 will 	 	
	 	 change its values on the Y (vertical) axis.  	

	 •	 If you modify your Start Color with three steps, Step Color 1 will remain 	 	
	 	 the same.  However Step Color 2 and Step Color 3 will form an imaginary ‘X’ 	 	
	 	 and their values will change on opposing diagonal Y axes.

Printing out a Custom Palette
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	 •	 Next, determine what Step Size you want to apply to the Color Finder palette.
	 	 	This is simply a question of how much you want your Start Color to fluctuate.
	 	 If your Start Color is close to the color you are looking  for, use a low Step
	 	 	Size. (i.e. 5-10) However, if your Start Color is not close to what you are 	 	
	 	 looking for, use  a higher Step Size.  You can enter any Step Size value 	 	
	 	 	between 1 and 40.
	 •	 As an example, let’s say your Start Color is R:20, G:80, B:70 and you select
	 	 Blue and Red to be your Step Colors.  You also enter a Step Size of 10.
 	 	 When the ‘Print Colors’ button is clicked, your Start Color will be in the middle 	
	 	 of the Color Finder palette and from there each color will vary the Blue and Red
	 	 values by 10.
	 •	 When you are finished selecting the Start Color, Step Colors, and the Step 	
		  Size, click on the Print Colors button.  This will print your Custom Color 	
		  Finder palette directly to your printer.
	 •	 After printing the Color Finder palette, transfer it to your selected substrate 		
	 	 and then try to match your desired color to one that is on the palette.  If you 	 	
	 	 find a suitable match, you are finished using the Color Finder tool.  Move on to
	 	 Section V, The Custom Palette.
	 •	 If you couldn’t find an accurate match on the first printed Color Finder Palette,
	 	 don’t worry.   Follow the asy steps below, and you can find a more suitable custom 	
	 	 color.

1.	 First, try to locate a new Start Color from the palette that is closer 	
	 than the original color.
2.	 Next, after finding a more suitable Start Color, write down that
	 color’s RGB value.  Here is how to obtain this value.  There are
 	 numbers under each color that are dependant upon which Step 	
	 Colors you chose.  For example, it might say R:32
	 G:80.  Take note of these values.  Then, at the bottom left of the 	
	 Color Finder palette you will see a full set of RGB values.  The new 	
	 Start Color’s RGB 	value would be R:32 G:80 and whatever the 	
	 RGB values are from the full set.

3.	 Lastly, plug the RGB values for the new Start Color into the boxes 	
	 in Color Finder,  choose your Step Size, and click on
 	 Print Colors once again.  Continue with steps 1-3 until you find your 	
	 desired color.
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V.  The Custom Palette
	 Let us assume that you have found the exact color you need using the Color Finder 	
	 tool.  What you will want to do next is apply these custom color values to either an
	 existing palette, or to create a new custom palette altogether.  This allows you
	 access to this color again should the same job arise.  
How to use Custom Palette:
	 •	 First, you need to assign the RGB values of the matched color from the
	 	 Color Finder palette to the Output Color RGB fields in the Custom 		
		  Palette section.
	 •	 Give your new custom color a descriptive Name in its designated field (e.g. 		
		  IBM Blue).
	 •	 Next, assign an RGB Input Color Value.  There are two methods to establish 	
	 	 this value.

1.	 If you have the original file, sample the color that was matched in your
	 graphic design application with the eye dropper tool.  This will give you 	 	
	 the RGB value of that color.  Input this value into the RGB Input Color 	
	 fields of the Custom Palette section.
2.	 If you do not have the original file or the artwork has not yet been
	 designed, simply click on the ‘Input Color Chooser’ button, and then click
	 on “Define Custom Colors”.  From the color matrix, find a color that
	 closely resembles the color that you are adding to the custom palette.
	 At the bottom-right of the color matrix window are the RGB values.  	 	
	 Simply click ‘OK’ and the RGB Input Color values will be automatically 	 	
	 entered.  Please take note of these RGB values for later use in your design 	
	 applications.

•	 Click the Add Color button.  A window will pop up asking you whether you
	 want to add the color to the palette for all substrates or just the current
	 substrate.  Click ‘YES’ here unless you have the same custom color saved on 	 	
	 palettes for other substrates.  Another window will then ask you if you want 	 	
	 to save the custom color for all resolutions or just the current one.  Click 	 	 	
	 ‘YES’ here unless you have the same custom color saved on palettes for other 	 	
	 resolutions.
•	 Lastly, click the Save Palette button.  When finished, simply Exit out of the window.

*	 The ‘Import Palette’ and ‘Export Palette’ buttons are convenient to have in the 	
	 event you need to transfer palettes to and from different computers.

VI. Adding Swatches to your Application Palette:
	 It is possible to add your custom color(s) swatch to an application palette as well.  	 	
	 You will need to take note of the Input Color RGB value that you assigned in the
	 previous step in order to create the new swatch.  Refer to your specific design 	 	
	 application software’s manual for instructions on this.
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Selecting Paper
For information on selecting the appropriate paper to use with your SubliJet R™ inks, please 
check our website at http://www.sawgrassink.com or call your authorized SubliJet reseller. While 
the use of copy paper or other inkjet paper will not harm your printer, the transferred results may 
be light, splotchy, or uneven. Some papers may even stick to the surface or leave a visible residue.

Heat Transfer Instructions
Because you can print on a variety of surfaces, you need to take all variables of the surface 
into account when selecting time, temperature, and pressure. Some of the variables are:
	 •	 Thickness of surface.
	 •	 Heat absorption; how fast the surface absorbs heat.
	 •	 Coatings used on materials to create a receptive surface for sublimation
	 	 inks. (Ceramics, Metals, Plastics, etc.)
	 •	 Accuracy of heat press unit. (Time, Temperature, and Pressure)

The information listed below are only guidelines. Due to the differences in heat presses and the various 
materials you will be printing on, it is not possible to give absolute figures. You should check with 
your supplier for specific heat transfer instructions or experiment to find your own preferred settings.

SURFACE Transfer Time
SubliJet

Transfer Time
SubliJet R TEMP P. S. I. REMARKS

CERAMIC
150-210 Seconds 150-210 seconds 350-

400oF
40 psi

Time varies with press, use 
green tile mat for ceramic tile 

FR PLASTIC 33 seconds 75-80 seconds 400oF 40 psi Remove Plastic

METAL 
(Other) White, 

Silver, Gold
40 seconds 60 seconds

375oF
- 400oF 40 psi

Time varies with metal manufacturer 
(Contact your reseller for correct 

time and temperature)
Place absorbent sheet on bottom plate 

of heat press.  Then place transfer 
paper face up on top of the absorbent.  

Next place the substrate face down 
on top of the transfer paper.  Remove 

paper from substrate immediately 
after transferring for best results.

METAL 
(Universal

Woods)
40 seconds 60 seconds 400oF 40 psi Use absorbent, remove plastic

MOUSE PADS 25 seconds 45 seconds 400oF 40 psi
POLYESTER 

FABRIC &
PERFORMANCE 

APPAREL

25 seconds 45 seconds 400oF 40 psi

SOFT L’INK™ 25 seconds 35 seconds 400oF 40 psi
Press for 5 secs to eliminate 
moisture, use Teflon sheet 
between sides of shirt to 
prevent “blow through”

UNISUB™ 
PRODUCTS

75 seconds 75-85 seconds 400oF 40 psi Remove Plastic
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Tips for Successful Sublimation 

POLYESTER FABRIC

Maintain appropriate heat press times.
	 •	 Shortened pressing times will result in good surface color but the sublimation 	 	
	 	 dyes will not completely penetrate the polyester fibers. This leaves the dyes 	 	
	 	 more susceptible to wash out.
	 •	 Longer pressing times will cause the dye molecules to penetrate deeper into 	 	
	 	 the fiber, creating a washed out look. For guidelines on transfer times, see the
	 	 Section entitled Heat Transfer Instructions, page 35.
Maintain appropriate heat press temperatures & pressure
	 •	 The correct temperature setting is vital for achieving desired results. Higher
	 	 temperatures can damage the polyester fibers to the point that they cannot 	 	
	 	 properly “hold” the dyes. For guidelines on transfer temperatures, see the 	 	
	 	 Section entitled Heat Transfer Instructions, page 35.
	 •	 Too much pressure on the heat press may cause the dyes to penetrate too
	 	 deeply into the fabric causing a washed out look. For guidelines on transfer 	 	
	 	 pressure see the Section entitled Heat Transfer Instructions.

METAL

To obtain the best results when printing onto metal, place the transfer between the 	 	
metal and an absorbent cloth or fresh, non-textured paper towel. This will absorb 	 	
any dyes that pass back through the paper and any moisture released during the
transfer process. If you have problems with inconsistently filled areas, this may 	 	
alleviate the problem.

CERAMIC TILES & MUGS
	
When transferring onto ceramic tiles and mugs, immediately peel the paper off of
the ceramic after removing it from the heat press. Once the paper has been removed,  
cool the ceramic by submerging it in cool water, or run water over it from the faucet.  If 
paper residue remains on the surface of the ceramic, clean with citrus cleaner. If you 
experience a significant paper-sticking problem, call your SubliJet reseller for assistance.
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Polyester T-Shirts

	 •	 The presence of moisture in your fabric can lead to bleeding of the image.  	 	
	 	 Remove moisture by pre-pressing your shirt for 10 seconds.  Use Teflon®

	 	 sheets between the front and back of the shirt to prevent the inks from 	 	
	 	 penetrating to the other side of the shirt.  If dye residue from your heat press
	 	 is being deposited on your shirts at any time, heat press a paper towel or 	 	
	 	 similar absorbent material to remove it.
	 •	 Using a lint brush before pressing can greatly reduce lint or debris on the shirt. 

MOISTURE & HUMIDITY PROBLEMS

The addition of moisture to the sublimation process can cause unwanted results. Under normal 
circumstances, the small amount of moisture that can accumulate in your paper is absorbed 
directly into the transfer substrate; however hard substrates like metal and ceramic are unable to 
absorb excess moisture. Some of problems that are attributed to moisture include: color shifting 
(colors lose accuracy), bleeding of the image, and uneven transfer of solid filled areas.

To avoid these problems
	 •	 Keep your paper in a dry place.
	 •	 If you suspect moisture, set the paper on your press for a few seconds. Do not
	 	 press it. Just expose it to the warmth. The heat radiating from the press 	 	
	 	 should help evaporate most of the moisture.
	 •	 To eliminate moisture in fabric, press the fabric for 10 seconds before doing 	 	
	 	 the heat transfer.
	 •	 Use an absorbent cloth or fresh, non-textured paper towel behind the transfer 	 	
	 	 sheet to absorb the moisture.
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Supplies & Equipment 
Contact your reseller to purchase sublimation supplies and equipment. For more information see 
the dealer locator option on our website at: www.sawgrassink.com. 

Operating Conditions
Certain environmental conditions should be taken into account for the operation of SubliJet R 
inks, including temperature and relative humidity.

•	 Supported Operating Conditions are 65° – 80° F with 40 – 60% relative humidity
•	 Optimum Operating Conditions are 68° – 75° F with 40 – 60% relative humidity

Storage
•	 Care should be taken to prevent storing SubliJet below freezing temperatures 
	 (32°F, 0°C). Do not expose SubliJet to extreme heat (temperatures in excess of
	 104°F, 40°C). If SubliJet has been in storage, you should allow it to reach room 	 	
	 temperature before using it.

•	 Do not expose SubliJet cartridges directly to light, especially sunlight, for extended 	 	
	 periods.	

•	 For best results, install your SubliJet cartridges by the date on the cartridge.  	 	
	 Please refer to the individual ink bag/cartridge for the specific ink expiration date.
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Troubleshooting
The troubleshooting tips found in this section relate mainly to problems that can be seen in 
transferred SubliJet images. If you are having problems related to the performance of your 
printer, please refer to the Problem Solving section found in the Ricoh GX7000 Printer 
User’s Guide.

My Image Has Gaps or Bands Present.
	 •	 Ensure that all of the printer’s nozzles are firing properly.  Perform a Nozzle 		
		  Check from the Utility tab of your printer driver. For further instructions, see 	
	 	 the Ricoh GX7000 Printer User’s Guide.
	 •	 If one or more of the nozzles fail to print, perform a Print Head Cleaning. For
	 	 further instructions, see the Ricoh GX7000 Printer User’s Guide.
	 •	 Check to make sure all OEM driver firmware has been updated per the OEM 	
	 	 driver installation instructions in the PowerDriver R section.
	 •	 If all nozzles are showing, check the Adjust Print Head Position & Adjust Paper
		  Feed options within the OEM driver to ensure the optimum alignment for correct printing. 
	 	 For instructions on how to use these features, please reference the Ricoh User’s
 	 	 Guide found on the driver CD provided with your printer.

The printer keeps showing a “Maintenance in Process.” 
message on the LED screen.
	 •	 To help keep optimum printing conditions and reduce missing or clogged nozzles, this 	
	 	 printer has a self cleaning mode.  When this message appears, the printer is doing a 	
	 	 cleaning and will resume printing when it is complete.

The colors in my transferred image are incorrect
	 •	 The image may need color adjustment. Use PowerDriver color matching
	 	 software. For more information on how to use this software, please see the 	 	
	 	 section entitled PowerDriver R Ricoh GX7000 User’s Guide.
	 •	 Ensure you used the right printer driver and driver settings. Please see the 	 	
	 	 section entitled PowerDriver R Ricoh GX7000 User’s Guide.
	 •	 Ensure you pressed the item with the proper time, temperature, and pressure. 		
	 	 For guidelines see the section entitled Heat Transfer Instructions.
	 •	 Verify all colors print correctly. Run the Nozzle Check utility and clean the 	 	
	 	 print heads as required.

My printout is really light on paper
	 •	 SubliJet R ink naturally looks muted before the heat transferring of the 
	 	 image.  After transferring is complete, SubliJet’s unique inks will produce a 
	 	 brilliant and durable final product.

My printout gets cut off on the bottom or side
	 •	 Verify the printer driver is setup for the correct paper size. Your printer driver 	 	
	 	 setting needs to match the paper size that is loaded in your printer.
	 •	 Ensure the right paper guide is in the proper position. When setting up the 	 	
	 	 printer, slide the right paper guide to the left until it clicks into position.
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Colors are light and splotchy, (Cont.)
	 •	 Verify your printer driver settings are correct. Please see the section entitled 	 	
	 	 PowerDriver R Ricoh GX7000 User’s Guide for additional information.
	 •	 Ensure you do not have a moisture problem. For more information, see the
	 	 Section entitled Moisture and Humidity on the Tips for Successful 	
		  Sublimation page.
	 •	 Ensure your substrate is designed to accept a sublimation transfer. Garments
	 	 made from natural fibers such as Cotton are not compatible with the 	 	
	 	 sublimation process.

My Image Looks Blurred.
	 •	 Ensure you pressed the item with the proper time, temperature, and pressure. 		
	 	 For guidelines, see the Section entitled Heat Transfer Instructions.
	 •	 Ensure you used a recommended paper. For more information, see the section 	
	 	 entitled Selecting Paper.
	 •	 Ensure you printed on the correct side of the paper. The print side is the bright 	
	 	 white side of the paper.
	 •	 Ensure you do not have a moisture problem. Try drying the paper on the press 	
	 	 or putting a paper towel behind the transfer when you heat press it. Read the
	 	 Section entitled Moisture and Humidity on the Tips for Successful 	
		  Sublimation.
	 •	 Verify that the printer’s print heads are properly aligned. For further instructions, 	 	
	 	 see the Ricoh GX7000 Printer User’s Guide.

My image looks good but it washes out
	 •	 Ensure you pressed the garment with the proper time, temperature, and 	 	
	 	 pressure. If so, try pressing longer to ensure that the dyes are penetrating the
	 	 fibers sufficiently. For guidelines, see the section entitled Heat Transfer 		
		  Instructions.
	 •	 Ensure you used a recommended paper. See the section entitled Selecting 		
		  Paper.
	 •	 Ensure your substrate is designed to accept sublimation transfers. Garments
	 	 made from natural fibers, such as cotton, are not compatible with the 	 	
	 	 sublimation process.

Colors are light and splotchy
	 •	 Ensure you printed on the correct side of the paper. The print side is the bright 		
	 	 white side of the paper.
	 •	 Ensure you used a recommended paper. For more information, see the section 	
	 	 entitled Selecting Paper.
	 •	 Ensure you pressed the item with the proper time, temperature, and pressure. 		
	 	 For guidelines, see the section entitled Heat Transfer Instructions.
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Technical Support
If you are having difficulties achieving good results from your SubliJet R™ inks, you have 
several support options:
1.	 Telephone:	 You may contact your authorized SubliJet reseller during their 	
	 normal 	hours of operation for assistance. A full listing of authorized SubliJet
	 Resellers is available on our Website at www.sawgrassink.com.  

	 In addition, you may also contact Sawgrass Technical Support at 
	 (888) 253-1679 during hours  8:30 AM until 5:30 PM Eastern Standard Time.	
2.	 Internet: Visit the Technical Support Area of the Sawgrass Technologies, 	
	 Inc.  	Website at www.sawgrassink.com.  The troubleshooting utility found here 	
	 will 	 	provide you with solutions to some of the most common problems.  You may
	 submit a detailed description of your problem if you need further assistance.
3.	 E-mail:	 You may e-mail Sawgrass Technical Support with a detailed 	 	
	 description of your problem at support@sawgrassink.com.
4.	 Fax:	 You may fax a detailed description of your problem to Sawgrass 			
	 Technical Support at (843) 849-3847.

Project Sublimation
Whether you are a current business owner adding sublimation to your line-up, a novice/
intermediate sublimation user who would like to learn more, or an entrepreneur exploring the dye-
sub industry, Project Sublimation is the industry’s choice for practical, hands-on instruction.  
From equipment and product overview to marketing and pricing your products; from the science 
of sublimation to color management, our two-day, interactive workshop series will give you the 
background and know-how needed to run a full-service sublimation business.
At Project Sublimation workshop events, you will also have the opportunity to network 
with fellow sublimation users across the US and Canada.   The new, enhanced Project 
Sublimation Website gives attendees access to the full business assets and forums, an 
invaluable resource for growing your sublimation business.
Isn’t it time you took your business to the next level?
Project Sublimation travels to cities throughout the United States and Canada.  Join 
us in a city near you for this dynamic, full-service workshop.  Spend two days with one of our 
experts and get a leg up on your competition.
Please visit us on the web at www.ProjectSublimation.com or phone us toll free at 
1.888.780.7349.



Sawgrass Technologies, Inc. ~ www.sawgrassink.com
42


